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Accessing Data from the Web Interface

This chapter provides information about accessing Cisco Mobile Wireless Transport Manager (MWTM) 
data from the MWTM web interface by using a web browser. 

This section contains:

• Supported Browsers, page 11-1

• Accessing the MWTM Web Interface, page 11-2

• Overview of the MWTM Web Interface, page 11-3

• Displaying the Home Page, page 11-7

• Downloading the MWTM Client from the Web, page 11-8

• Displaying Alarms and Events, page 11-10

• Displaying Summary Lists, page 11-11

• Displaying Status and Summary Reports, page 11-12

• Viewing Report Status, page 11-12

• Viewing Historical Statistics Report Settings, page 11-14

• Tools, page 11-15

• Understanding Groups, page 11-18

• Viewing Statistics, page 11-21

Supported Browsers
The MWTM web interface is supported on the following browsers:

• Microsoft Internet Explorer version 6.0 and 7.0 on Microsoft Windows operating system

• Mozilla Firefox 2.0 on Solaris 9 and Red Hat Linux Enterprise AS 4.0 operating system

• Mozilla Firefox 3.0 on Solaris 10 and Microsoft Windows operating system

Note The first time you attempt to connect to the MWTM server using Firefox 3.0, you must add an 
exception to allow the connection. See Importing an SSL Certificate to an MWTM Client, 
page 2-23 for more information.
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Checking Your Browser
To check your browser and screen settings, from the MWTM web interface Home page, select Browser 
Checker. 

Note Opening the MWTM in an unsupported browser generates a warning. Also, if JavaScript is not enabled, 
the MWTM web interface cannot function.

The Browser Checker window contains:

Accessing the MWTM Web Interface
The home page of the MWTM web interface is the first window to appear when you launch the MWTM 
web interface. 

To access the MWTM web interface, use one of these methods:

• Open a browser and enter http://mwtm_server:1774 in the Address field. (1774 is the default port.)

Note Accessing the MWTM web interface through a URL other than http://mwtm-server:1774 is not 
supported. 

• From the MWTM client interface, choose View > Web > Home.

The MWTM Home page window opens in the browser window. For details about the Home page, see 
Displaying the Home Page, page 11-7.

Pane or Field Description

Browser Information

Browser The name and version of the browser you are using. 

Browser User Agent Text string sent to identify the user agent to the server. Typically includes information such as the 
application name, version, host operating system, and language.

Platform The platform type. For example, Win32.

Cookies Enabled Whether you have cookies enabled on the browser (Yes or No). 

Javascript Enabled Whether Javascript is enabled (Yes or No).

AJAX Component The Asynchronous JavaScript and XML (AJAX) component sends asynchronous HTTP update 
requests. The MWTM web application is only accessible to web browsers that have an AJAX 
component enabled. Typical values include XMLHttpRequest (for Mozilla-based browsers) and 
MSXML2.XmlHttp (for IE 6).

Screen Information

Size Resolution of the display; for example, 1024 x 768. 

Color Depth Depth of the color display; for example, 16. 
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Overview of the MWTM Web Interface
The MWTM web interface shows basic information about the events and objects that the MWTM 
manages. The MWTM web interface shows:

MWTM Web Interface Navigation Tree
You can easily navigate the features of the MWTM web interface by using the navigation tree in the left 
pane. By default, the navigation tree is sorted by alarm severity, with objects having the most severe 
alarms appearing at the top of the tree.

Note To learn more about alarm severity, see Chapter 9, “Managing Alarms and Events.”

To view detailed information about a selection in the navigation tree, click the item in the tree. The 
content area in the right pane shows details about the chosen item. A plus (+) or minus (-) just to the left 
of the item indicates whether the item has subtending items under its domain. 

The MWTM automatically updates the navigation tree when changes occur to discovered nodes or to the 
network. When any changes occur in the MWTM client navigation tree, the MWTM web interface 
reflects these changes in its navigation tree. For example, if you delete a node in the MWTM client, the 
MWTM web interface removes that node from its navigation tree. 

Note For information about the navigation tree in the MWTM client interface, see MWTM Client Navigation 
Tree, page 4-16.

Pane Description

Title Bar Shows:

• Mobile Wireless Transport Manager, version, and server name

• Managed networks (can be any combination of IPRAN, ITP, CSG1, CSG2, GGSN, BWG and/or 
HA)

• Logout (appears only if you enable user access; see Configuring User Access, page 2-1)

• Help—Click this link to access context-sensitive online help

• Preferences—Click this link to access preferences that you can change from the web interface (see 
Changing Web Preference Settings, page 5-18)

Location bar Shows where you currently are in the MWTM navigation tree.

Navigation Tree In the left pane, shows a tree of information organized by categories (see MWTM Web Interface 
Navigation Tree, page 11-3).

Content Area In the right pane, shows detailed information about the object chosen in the navigation tree (see MWTM 
Web Interface Content Area, page 11-4).
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The MWTM web interface navigation tree contains:

MWTM Web Interface Content Area
The content area of the MWTM client interface is fully described in MWTM Client Content Area, 
page 4-17. That description also applies to the web interface. Additional navigational features that 
appear only in the web interface include:

• Customizing Date Ranges, page 11-5

• Using the Toolbar, page 11-5

GUI Element Description

Sort tree by name

Sorts all content in the navigation tree alphabetically by name. 

Sort tree by status

Sorts all content in the navigation tree by status, from the highest alarms to the lowest.

Home Shows links to MWTM client software, Cisco documentation, and information about the MWTM on the 
Cisco web (see Displaying the Home Page, page 11-7).

Administrative Shows MWTM system information including messages, logs, status, and properties (see Viewing 
Administrative Information from the Web Interface, page 12-1).

If MWTM User-Based Access is enabled, only users with authentication level 3 (Network Operator) and 
higher can see all options. Users of all other levels see only the System Information and System Status 
panes.

Active Alarms Shows alarms (see Displaying Alarms and Events, page 11-10).

Event History Shows information about the events delivered by the MWTM event logger and event processor for events 
that the MWTM event logger and event processor deliver for all objects in the current network view (see 
Displaying Alarms and Events, page 11-10).

Summary Lists Shows summaries of all objects that the MWTM manages (see Displaying Summary Lists, page 11-11).

Reports Statistics—Shows statistic reports, which can be 15-minute, daily, or hourly for AS, ASP, Link, Linkset, 
MLR, MSU, and also Event Metrics. For more information, see Viewing Statistics, page 11-21.

Accounting—Shows accounting reports for MTP3, AS/ASP, and GTT.

Subscriber Count—Shows subscriber account reports for HA, CSG, GGSN, and BWG. 

File Archive Events—Shows archived events (see Viewing Archived Event Files on the Web, page 9-21). 
Reports—Shows archived reports (see Viewing File Archive Reports, page 13-60).

Tools Provides tools for launching CiscoWorks, CiscoView, and Device Center. Also provides a search tool 
for Home Agent (HA) subscribers (see Tools, page 11-15).

Groups Displays user-defined groups (see Understanding Groups, page 11-18).

DEFAULT View Shows a current list of nodes in the DEFAULT view.
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Customizing Date Ranges

Some windows require that you select date ranges for generating historical graphs (see Displaying 
RAN-O Statistics, page 11-21). Standard date ranges (for example, Last 24 Hours or Last 7 Days) are 
available from a drop-down menu. However, if you want to customize the date range:

Step 1 Click the Customize Date and Time Range tool  in the toolbar of the content area. A dialog box 
appears. 

Step 2 Enter a:

a. Begin Date and End Date; or, select those dates by clicking the Calendar tool . 

b. Begin Hour and End Hour from the drop-down menus, if they are available.

Note The dialog box shows an error if the End Date is equal to or less than the Begin Date. Correct 
the error before proceeding. 

Step 3 Click OK to accept the date and time changes; or, Cancel to cancel this operation.

The MWTM web interface generates a report for the specified time period.

Using the Toolbar

Depending upon the object you select in the navigation tree, the web interface toolbar provides these 
tools and options:

Tool or Function Description

Last Updated Date and time the MWTM last updated the information on the page.

Page Shows where you are (page X of X total pages) and lists the total number of entries.

 Refresh Forces a refresh of the current web page. Click this icon to refresh the current page.

Status Refresh Interval Allows you change the default refresh interval of 180 seconds. Enter a value between 180 and 900 
seconds. 

Note Changes you make are temporary to the current page. Navigating away from the page sets 
the status refresh interval back to the default setting. To change the default setting, see 
Changing Web Preference Settings, page 5-18.

Page Size Drop-down list of different page sizes (the number of table rows in the display). Click the 
drop-down arrow to select a different value. The value that you select becomes the default page size 
for all pages in the web interface.

The title bar displays the current page and total number of table entries.

> Advances the display to the next page of information.

>> Advances the display to the last page of information.

< Advances the display to the previous page of information.

<< Advances the display to the first page of information.

 Modify event filter Opens the Event Filter dialog box. You can create a filter to display only the events in which you 
are interested (see Setting Alarm or Event Filters, page 9-10).
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 Remove filter Applies or removes a filter that you created. 

Archived Link that shows only archived alarms or events. This link appears when you select Event History 
or Active Alarms in the navigation tree. It also appears when you click the Alarms tab or Recent 
Events tab for a specific object.

Caution In the Server.properties file, you can limit the number of rows in the archived events table 
with the MAX_ARCHIVED_EVENT
_DB_ROWS property. The default value is 200,000. Increasing this value can have 
severe impact on server performance and can cause the server to run out of memory.

 Customize Date 
and Time Range

Opens the Customize Date and Time Range dialog box (see Customizing Date Ranges, page 11-5).

 Graph Series 
Editor

Opens the Graph Series Editor dialog box, which provides a check box for each available data 
series. Check the check box to display a series, and uncheck the check box to hide a series. 

If you click OK without selecting a series, it is the same as clicking Cancel.

By default, the MWTM displays no more than 12 series by default. To change this default setting, 
see Display Series Dialog Box, page 8-104.

Run Runs the report type for the chosen duration.

 Export Exports the raw graph data to a report with comma-separated values (CSV file). You can save this 
file to disk or open it with an application that you choose (for example, Microsoft Excel).

Data Range Label that shows the chosen time range for the historical statistics.

Type Drop-down list of report types.

Duration Drop-down list of default time ranges. Select one of these options, then click the Run tool. To 
specify a nondefault time range, click the Customize Date and Time Range too.

Output Type Drop-down menu that provides these options:

• Graph—Displays statistical data in graphs and tables

• Table—Presents statistical data in tabular format only

• CSV—Exports statistical data using comma-separated values

Pause Pauses the page refresh feature. Click Pause to disable the page refresh that would normally occur 
after the Status Refresh Interval. Click Pause again to re-enable the Status Refresh Interval.

Edit Notes Enables you to edit or add notes for events.

Slow Poller Interval Allows you to change the default slow poller interval of 60 seconds. Enter a value between 60 and 
300 seconds. 

Note Changes you make are temporary to the current page. Navigating away from the page sets 
the status refresh interval back to the default setting. To change the default setting, see 
Changing Web Preference Settings, page 5-18.

Tool or Function Description
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Displaying the Home Page
The MWTM web interface Home page provides access to MWTM client software, Cisco documentation, 
and information about the MWTM.

To access the Home page of the MWTM web interface, click Home under the navigation tree in the left 
pane. 

Fast Poller Interval Allows you to change the default fast poller interval of 15 seconds. Enter a value between 5 and 60 
seconds. 

Note Changes you make are temporary to the current page. Navigating away from the page sets 
the status refresh interval back to the default setting. To change the default setting, see 
Changing Web Preference Settings, page 5-18.

Reset Counters Enables you to modify the counter reset settings to one of the following: 

• Show counters since reboot

• Show counters since last poll

• Show counters since user reset

Launch Drop-down list of applications you can launch:

• CiscoView

• Device Center

After you choose the application, click the Run icon to launch it.

Severity Drop-down list of the severities of alarms or events. Severity can be Critical, Major, Minor, 
Warning, Informational, Indeterminate, or Normal. 

This drop-down list appears when you select Event History or Active Alarms in the navigation tree. 
It also appears when you click the Alarms tab or Recent Events tab for a specific object.

Change Severity Button to change the severity level of an alarm or event. 

To change the severity level, select one or more alarms or events by clicking the corresponding 
check boxes, choose a severity from the Severity drop-down list, then click Change Severity.

This button appears when you select Event History or Active Alarms in the navigation tree. It also 
appears when you click the Alarms tab or Recent Events tab for a specific object.

Clear Selection Link to clear the selection of one or more events or alarms. To select one or more alarms or events, 
check the corresponding check boxes. To clear the selection, click the Clear Selection link.

This button appears when you select Event History or Active Alarms in the navigation tree. It also 
appears when you click the Alarms tab or Recent Events tab for a specific object.

Toolbar for alarms and 
events

The web interface provides the same toolbar for alarms and events as the client interface. For full 
descriptions of these tools, see Toolbar Buttons, page 9-7.

Tool or Function Description
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The content area in the right pane shows these GUI elements:

Downloading the MWTM Client from the Web
You can access the MWTM client installation software for Linux (unsupported), Solaris, and Windows 
from the MWTM web interface Home page. This access is useful if you do not have the CD-ROM, or if 
you prefer to download the software by using your web browser. Once you have downloaded the MWTM 
client installation software to your workstation, you must install the software on your local system.

Pane GUI Element Description

Client Software Download Windows Client

Download Solaris Client

Download Linux Client

Browser Checker

Shows the download instructions for the:

• Windows client

• Solaris client

• Linux client

• Information about the browser and screen display

For details, see Downloading the MWTM Client from the Web, page 11-8.

MWTM on 
Cisco.com

MWTM Home Page

MWTM Software Download 
Page

Latest MWTM 
Documentation

Engineering Software Updates 
(FTP)

Shows hyperlinks to:

• MWTM information on the Cisco website

• MWTM software download from Cisco.com

• Most recent versions of MWTM documentation

• Software updates provided by Cisco Engineering

For details, see Accessing Software Updates and Additional Information, 
page 11-10.

Documentation Help Home Page

Release Notes

Install Guide

User Guide

OSS Integration Guide

Alarm Guide

Frequently Asked Questions

MWTM Server Help 
Command

Shows: 

• Online Help system for the MWTM

• PDF versions1 of the:

– Release Notes for the Cisco Mobile Wireless Transport Manager

– Installation Guide for the Cisco Mobile Wireless Transport 
Manager

– User Guide for the Cisco Mobile Wireless Transport Manager

– OSS Integration Guide for the Cisco Mobile Wireless Transport 
Manager

– Alarm Guide for the Cisco Mobile Wireless Transport Manager

• HTML version of the FAQs

• CLI output of the mwtm help command

For details, see Viewing the MWTM Technical Documentation, 
page 11-10.

1. To access the latest versions, go to the parent index for Cisco MWTM user documents: 
http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html
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For more information about installing the MWTM client software by using a web server, see the 
following chapters in the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.1:

• “Installing the MWTM on Solaris”

• “Installing the MWTM on Windows”

• “Installing the MWTM on Linux” 

Related Topics

• Downloading the Solaris Client, page 11-9

• Downloading the Windows Client, page 11-9

• Downloading the Linux Client (Unsupported), page 11-9

Downloading the Solaris Client
To access the MWTM Client for Solaris page, select Download Solaris Client.

The web interface shows the supported Solaris versions and instructions for downloading the Solaris 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.1 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.

Downloading the Windows Client
To access the MWTM Client for Windows page, select Download Windows Client.

The web interface shows supported Windows versions and instructions for downloading the Windows 
setup program. After downloading the setup program onto your desktop or other Windows directory, 
double-click the setup.exe icon to start the setup program and launch the installation wizard. See the 
Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.1 for detailed procedures.

To start the client after installation, launch it from the Windows Start menu or double-click the MWTM 
Client icon on your desktop.

Downloading the Linux Client (Unsupported)
To access the MWTM Client for Linux page, select Download Linux Client. 

Note The MWTM does not support the MWTM client for Linux. Use the MWTM Linux client under 
advisement.

The web interface shows the supported Linux versions and instructions for downloading the Linux 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.1 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.
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Accessing Software Updates and Additional Information
You can access this information about the MWTM from the MWTM web interface Home page. To:

• View information about the MWTM or any other Cisco product available on Cisco.com, select Cisco 
Home Page.

• Read Cisco literature associated with the MWTM, including product data sheets, Q and As, and 
helpful presentations, select MWTM Home Page.

• Access software updates for the MWTM from Cisco.com for FTP, select Engineering Software 
Updates (FTP). The Cisco Systems Engineering FTP server page appears.

• Access software updates for the MWTM from Cisco.com, select MWTM Software Download 
Page. The Software Download page for the MWTM appears.

• Access the most recent versions of customer documentation for the MWTM, select Latest MWTM 
Documentation. The Cisco Mobile Wireless Transport Manager documentation page on Cisco.com 
appears. From this page, you can view the latest versions of MWTM release notes, installation 
guides, and end-user guides.

Note If you cannot access Cisco.com from your location, you can always view the customer 
documentation that was delivered with the MWTM software. See the “Viewing the MWTM 
Technical Documentation” section on page 11-10.

Viewing the MWTM Technical Documentation
From the MWTM web interface Home page, you can view this MWTM technical documentation. To 
view the:

• Entire Cisco Mobile Wireless Transport Manager Help System, select Help Home Page.

• Entire User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1 as a PDF file on the web, 
using the Adobe Acrobat Reader, select User Guide (PDF).

• Entire Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.1 as a PDF file on 
the web, using the Adobe Acrobat Reader, select Install Guide (PDF).

• Entire Release Notes for the Cisco Mobile Wireless Transport Manager 6.1.1 as a PDF file on the 
web, using the Adobe Acrobat Reader, select Release Notes (PDF).

• Frequently Asked Questions (FAQs) about the MWTM, select Frequently Asked Questions.

• Syntax for every MWTM command, select MWTM Server Help Command.

Caution These PDF versions of technical documents might not be the latest versions. For the latest versions, go 
to: http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html.

Displaying Alarms and Events
To display alarms in the web interface, click Active Alarms in the navigation tree, or select an object in 
the navigation tree and click the Alarms tab.
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To display events in the web interface, click Event History in the navigation tree, or select an object in 
the navigation tree and click the Recent Events tab.

Viewing alarms and events in the web interface is essentially the same as viewing them in the MWTM 
client. Only minor differences exist:

• A paging feature for paging through large tables.

• A refresh interval that you can change.

• An Archived link for viewing archived alarms.

• Alarm selection by check box and a Clear Selection link.

• Severity drop-down list and a Change Severity button.

For detailed descriptions of these tools, see the “Using the Toolbar” section on page 11-5.

For descriptions of the columns, see the “Right-click Menus” section on page 9-9.

Displaying Summary Lists
Displaying Summary Lists in the web interface is essentially the same as displaying them in the MWTM 
client. Only minor differences exist. Clicking on an object under the Summary Lists in the web interface 
causes the content area to show information about the object. 

For details on:

• Navigating table columns, see Navigating Table Columns, page 5-22. 

• The toolbar, see Using the Toolbar, page 11-5.

For complete information about Summary Lists, see the “Displaying Object Windows” section on 
page 6-2.

Displaying Software Versions
The Software Versions table lists the software versions for each node the MWTM manages.

To access the Software Versions page:

• From the Web interface navigation tree, select Summary Lists > Software Versions.

• From the MWTM main window, select View > Web > Software Versions.

For details on:

• Navigating the columns of the Software Versions table, see Navigating Table Columns, page 5-22. 

• The toolbar, see Using the Toolbar, page 11-5.

The Software Versions table contains:

Column Description

Name Name of the node.

Node Type Type of node.

Software Version Software version used by the node.

Software Description Full software version information. 
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Displaying Status and Summary Reports
You can view a table, graph, or CSV file that shows the overall state of the available MWTM reports, the 
time the server took to gather data from the network and store it in the database, and enable or disable 
reports from the report page. You can also run hourly and daily performance summary reports. 

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in Viewing Report Status, page 11-12.

Step 2 From the Type pulldown menu, select one of the following types of reports:

• Report Status—See •Second entry begins calculating useful accounting statistics and, if the data 
being collected appears valid, begins generating the report., page 13-84.

• Performance Summary Hourly—See Performance Summary Hourly Report, page 11-13.

• Performance Summary Daily—See Displaying Software Versions, page 11-11.

Step 3 Select a duration and output type. See the “Using the Toolbar” section on page 11-5 for more information 
about these fields.

Viewing Report Status
The Reports page in the MWTM web interface allows you to view a table, graph, or CSV file that shows 
the overall state of the available MWTM reports. You can also enable or disable reports from the report 
page.

Note Only reports that run on a regularly scheduled interval are displayed in the Hourly and Daily data. 
Reports that run continuously are not displayed.

Note Only reports that run on a regular scheduled interval display information in the following columns:Last 
Start Time, Last End Time, and Duration. Reports that run continuously display N/A for these columns. 
A report that has not yet run has Unknown in the above columns

To access the main Reports page:

Step 1 Do one of the following:

• In a web browser, launch the MWTM web interface (see Accessing the MWTM Web Interface, 
page 11-2). In the navigation tree, click Reports. 

• From the MWTM client, in the MWTM main window, choose View > Web > Reports.

The Reports page in the content area shows the Report Type and the status (enabled or disabled). If you 
have generated a report, a green status ball and the word “Enabled” appear in the Status column. If you 
have not generated a report, a red status ball and the word “Disabled” appears.

Note Clicking a Report Type takes you directly to the report data page.
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The Status column indicates whether you have enabled or disabled data gathering for the specified report 
type.

Step 2 To enable a report in the MWTM Web interface, click “Disabled” in the Status column. The Status 
changes “Enabled” and a green status ball appears.

Performance Summary Hourly Report
The Performance Summary Hourly Report shows the time it takes to gather the data from the network 
and store it in the database. This report shows data for reports that are invoked via an hourly cronjob only 
and not reports that run continuously.

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in •Second entry begins calculating useful accounting statistics and, if the data being 
collected appears valid, begins generating the report., page 13-84.

Step 2 From the Type pulldown menu, select Performance Summary Hourly.

Performance Summary Daily Report
The Performance Summary Daily Report shows the time it takes to gather the data from the network and 
store it in the database. This report shows data for reports that are invoked via a daily cronjob only and 
not reports that run continuously.

GUI Element Description 

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-5.

Table If you select the Output Type Table, the table contains:

• Report Type—Type of report.

• Start Time (timezone)—Time the report started.

• End Time (timezone)—Time the report ended. 

• Duration (secs)—Time it took to run the report.

• Object Count—Number of objects on which the report was run.

Note If the Output Type is Table or CSV, the same data is presented but the column headings are 
labeled by data type.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Duration (Secs) If Output Type is Graph, Y-axis label that shows duration in second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.
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Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in •Second entry begins calculating useful accounting statistics and, if the data being 
collected appears valid, begins generating the report., page 13-84.

Step 2 From the Type pulldown menu, select Performance Summary Daily.

Viewing Historical Statistics Report Settings

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described inViewing Report Status, page 11-12.

Step 2 Click the Settings tab. The Historical Stats Report Settings information is displayed.

You can click on Disabled or Enabled to change the state of any of the reports.

You can click on any field, except for the Reports Directory field, to modify its value.

GUI Element Description 

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-5.

Table If you select the Output Type Table, the table contains:

• Report Type—Type of report.

• Start Time (timezone)—Time the report started.

• End Time (timezone)—Time the report ended. 

• Duration (secs)—Time it took to run the report

• Object Count—Number of objects on which the report was run. 

• If the Output Type is Table or CSV, the same data is presented but the column headings are 
labeled by data type.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Duration (Secs) If Output Type is Graph, Y-axis label that shows duration in second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Bits/Sec or Bytes/Sec If Output Type is Graph, Y-axis label that shows traffic rate in bits per second. The Y axis 
automatically scales to the interface speed. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.
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Tools
To access launch and search tools, click Tools in the navigation tree of the MWTM web interface. The 
following options are available:

• Launch Tools, page 11-16

• Event Sounds, page 11-16

• Using the Batch Provision Tool, page 11-16

• Search Tools, page 11-17

Field Description

General Settings Reports Directory Specifies the directory in which the MWTM reports are stored. You 
must use the CLI to change the directory in which the reports are 
stored; you cannot click on this field to modify it.

Time Mode Specifies the time mode, either 12-hour or 24-hour, for the reports.

Master Report Flag If this option is enabled, the individual report settings are used. If this 
is option is disabled, all reports are turned off.

Perform Disk Space 
Checking

Specifies whether disk space checking is enabled or disabled.

Export Reports Specifies whether to automatically generate reports in CSV format.

15 Min Stats Aging (Days) Specifies the database aging value for 15-minute statistics. When 
records exceed the specified value, they are aged out of the database.

Hourly Stats Aging (Days) Specifies the database aging value for hourly statistics. When records 
exceed the specified value, they are aged out of the database.

Daily Stats Aging (Days) Specifies the database aging value for daily statistics. When records 
exceed the specified value, they are aged out of the database.

Monthly Stats Aging (Days) Specifies the database aging value for monthly statistics. When 
records exceed the specified value, they are aged out of the database.

Custom Stats Aging (Days) Specifies the database aging value for custom statistics. When 
records exceed the specified value, they are aged out of the database.

ITP Report Settings Show links with no capacity 
set (nullcaps)

Specifies whether to show links/linksets that do not have planned 
send and receive capacities. 

Show SCTP IP Links Specifies whether to show SCTP IP links. 

High In-Service Ratio 
Threshold

Displays the high value for the In-Service ratio threshold.

High Utilization Ratio 
Threshold

Displays the high value for the utilization ratio threshold.
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Launch Tools
If you have integrated with a CiscoWorks server, one or more of the following applications appears in 
the Launch pane as active links:

• CiscoView

• CiscoWorks LMS Portal

• Device Center

The name of the server appears in parentheses following the application names. To launch an application, 
click the application name. See Integrating the MWTM with Other Products, page 5-35.

Event Sounds
The Event Sounds tool allows you to select a sound to be played when the client loses its connection to 
the MWTM server. By default, no sound is played when the client loses its connection to the server. You 
must select a sound to be played. 

Step 1 Click Tools in the navigation tree of the MWTM web interface. From the Client disconnect sound 
pulldown menu, select a sound. The sound you selected is saved. 

Step 2 After selecting a client disconnect sound, click Play to sample the sound. 

Note Make sure you are not logged into the MWTM client at the same time that you are changing the client 
disconnect sound in the MWTM web interface. Any sound changes you make using the MWTM client 
override changes you make using the web interface.

You can use the MWTM client interface to create and change event sound filters for the MWTM client 
as explained in Setting Sounds for Events at an MWTM Client, page 9-38.

Using the Batch Provision Tool

Step 1 Click Tools in the navigation tree of the MWTM web interface, then click Batch Provision. This option 
appears only if you have previously created a provisioning group such as HA config, GGSN config, CSG 
Config, IP-RAN Config, or RAN-O Config. 

Step 2 In the first pane, from the Group pulldown menu, select the group for which you want to batch script.

The second pane updates with the batch scripts applicable for the group type you selected in the previous 
pane. 

Step 3 In the second pane, from the Batch pulldown menu, select the script that you want to create. The contents 
of the batch script are displayed for the batch you selected.

Step 4 In the third pane, click Provision. Click the Write Mem option to save the script to the running 
configuration.

If nodes in the group are not all running the same Cisco IOS version software, a dialog box appears 
asking whether you want to continue or cancel the operation.
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When a batch script is created, the Cisco IOS version of the node that the script was created against is 
persisted with the batch script. If the Cisco IOS version of the batch script does not match the IOS 
version for the master node in the group, a dialog box appears asking you whether you want to continue 
or cancel the operation.

Related Topic

• About Provisioning, page 8-43

Search Tools

Note You must have the Cisco Home Agent (HA) network enabled to use this tool (for details on enabling HA, 
see mwtm manage, page B-43).

The Search pane provides a tool that you use to search for a specific subscriber across one or more 
designated Cisco Home Agent (HA) routers or to search for a GGSN subscriber. These tools are useful 
for troubleshooting problems that subscribers might report. 

In the Search pane, click one of the following options:

• Search for Home Agent Subscriber (See Searching for Home Agent Subscribers, page 11-17.)

• Search for GGSN Subscriber (See Searching for GGSN Subscribers, page 11-18.)

Searching for Home Agent Subscribers

Step 1 Cick Tools in the navigation tree of the MWTM web interface, then select Search for Home Agent 
Subscriber.

Step 2 Click the Identifier Type radio button:

• Network Access Identifier—Use this option if you know the subscriber’s network access identifier 
(NAI); for example, jdoe@xyz.com.

• IP Address—Use this option if you know the subscriber’s IP address

Step 3 Depending on your selection in Step 2, enter the subscriber’s NAI or IP address in the Mobile Node 
Identifier field.

Step 4 In the Select Groups to Search pane, click on the group(s) for which you want to search for Home 
Agents. This field is only available if you have previously created an HA config, HA report, or General 
group. (See Creating Groups, page 11-18.)

Step 5 In the Select Home Agents to Search pane, check the check boxes of the Home Agents that you want to 
search. (The default setting is all Home Agents.) Click Select All to check all boxes and search all Home 
Agents. Click Deselect All to clear all check boxes.

Step 6 To conduct the search, click the Search button. 

The Search Results popup window appears.

Step 7 If the search successfully locates the subscriber, and you want to troubleshoot the problem, click the 
Troubleshoot Subscriber button in the Search Results popup. 

The MWTM automatically navigates to the Troubleshooting tab of the HA device.
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Step 8 For more information about troubleshooting devices by using the Troubleshooting tab, see Viewing 
Troubleshooting, page 8-40.

Searching for GGSN Subscribers

Step 1 Cick Tools in the navigation tree of the MWTM web interface, then click Search for GGSN Subscriber.

Step 2 In the MSISDN field, enter the MSISDN for which you want to search.

Step 3 In the Select Groups to Search pane, click on the group(s) for which you want to search for GGSN 
subscribers. This field is only available if you have previously created a GGSN config, GGSN report, or 
General group. (See Creating Groups, page 11-18.)

Step 4 In the Select GGSN Nodes to Search field, select all the GGSN Nodes on which you want to search for 
the MSISDN you entered. Click Select All to check all boxes and search all GGSN nodes. Click Deselect 
All to clear all check boxes.

Step 5 To conduct the search, click the Search button. 

The Search Results popup window appears.

Step 6 If the search is successful, you can select from the matching GGSNs to troubleshoot the subscriber by 
clicking the Troubleshoot Subscriber button in the Search Results popup.

Understanding Groups
MWTM allows you to create groups of nodes that can simplify operations. You can create groups using 
the MWTM web interface and then perform operations against all nodes of a group instead of performing 
the operation against each node individually. You can also perform searches on groups. For example, you 
can search for a home agent subscriber on nodes within a specific group. 

For provisioning groups, the master node is the first node in the group. The master node is used to 
determine provisioning commands.

Related Topics

• Creating Groups, page 11-18

• Editing Groups, page 11-19

• Viewing Group Summary Information, page 11-20

Creating Groups

Note This option is available to users with authentication level Power User (level 2) and higher.

You can create the following types of groups:

Step 1 From the web interface, click Groups.

Step 2 Click the Create icon. The New Group form appears.
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Step 3 Complete the New Group fields: 

Note If a group contains non-existent nodes or if you add a node of the wrong type to a group, the 
group will be invalid. 

Step 4 Click OK. 

The Edit window appears displaying information about the group you just created. See Viewing Group 
Summary Information, page 11-20 for more information.

Related Topics

• Understanding Groups, page 11-18

• Editing Groups, page 11-19

• Viewing Group Summary Information, page 11-20

Editing Groups
After you have created a group, you can add nodes to and remove nodes from the group. You can also 
order the nodes within the group. 

Note This option is available to users with authentication level Power User (level 2) and higher. If you do not 
have the required privileges you will not see the Edit tab.

Step 1 From the web interface, click Groups > group name.

Step 2 Click the Edit tab. The Group Settings pane displays the group name and group type.

Field Description

Name Enter a name for the group

Type From the pulldown menu, select the group type:

CSG configuration

CSG report

GGSN configuration

GGSN report

General—Any node can be in the general group.

HA configuration

HA report

IPRAN configuration

RAN-O configuration
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Step 3 In the Group Members pane, specify to display available members by Nodes or by Groups. You might 
want to view members by Group if you want to copy all members of one group to another group. The 
available members or groups are displayed. 

Note Only valid nodes for a group are displayed in the Available members/groups list. A group is 
invalid if it contains non-existent nodes or if the group contains nodes of the wrong type.

Step 4 Click on a member or group to add to the specified group, then click Add. The member or group is added 
to the Selected Members list. 

Step 5 To remove a member, click on the member in the Selected Members list, then click Remove.

Step 6 To order the nodes in a group, use the Raise and Lower buttons. 

For provisioning groups, the master node is the first node in the group. The master node is used to 
determine provisioning commands.

Viewing Group Summary Information
From the web interface navigation tree, click Groups to display the Group Summary List. 

Displaying Group Details

Step 1 From the web interface, click Groups > group name. You can click on any of the following tabs for more 
information about the specified group:

Details—See Viewing Group Details, page 11-21.

Notes—See Viewing Notes, page 6-39.

Events—Displays events associated with the nodes in the group only. See Displaying Alarms and Events, 
page 11-10.

Alarms—Displays alarms associated with the nodes in the group only. See Displaying Alarms and 
Events, page 11-10.

Edit—See Editing Groups, page 11-19.

Field Description

Name Name of the group.

Group Type Type of group.

Size Number of nodes in the group.

Notes Displays any notes attached to the group.

Valid Yes indicates the group is valid. No indicates the group is not valid. A group 
is invalid if it contains non-existent nodes or if the group contains nodes of 
the wrong type. 

Last Verified Time and date group was last verified. 
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Viewing Group Details

Step 1 From the web interface, click Groups > group name. 

Step 2 Click Details. Detailed information about the specified group is displayed. See Nodes Table, page 6-5 
for descriptions of the fields. 

The Group Member Verification Status field specifies that status of each group member as it exists in the 
group. If the group is not valid, this field indicates which node is causing the group to not be valid. 

Viewing Statistics
You can use statistics for capacity planning and trend analysis. For example, you can generate graphs, 
tables, or CSV files:

• For a specified time range to display historical statistics for customer busy-hours. 

• To show the maximum send and receive traffic over a specified time period. 

• To show data on a 15-minute, daily, or hourly basis. 

MWTM provides two types of statistics:

• Real-time statistics—The MWTM provides real-time (not historical) performance statistics and 
error information occurring in real time. The MWTM client also displays graphs for real-time 
statistics. You use real-time statistics for troubleshooting active problem areas in your network. See 
Displaying RAN-O Statistics, page 11-21 and Displaying Error Statistics, page 11-25

• Historical reports (statistics). These reports are available on the MWTM web interface only.

These statistics vary by the time frame over which they are collected and stored and for some 
domains, the statistics gathered vary. For example, real-time SCTP Association Statistic Details 
describes link-level SCTP statistics collected every 15 seconds. The SCTP historical reports 
describe device-level SCTP statistics for all of the SCTP links on a specific device over 15 minute, 
hourly, and daily intervals. 

Displaying RAN-O Statistics
You can view real-time performance data for a shorthaul or backhaul interface in the MWTM:

• Web interface by selecting a shorthaul or backhaul interface in the navigation tree and clicking the 
Shorthaul Performance or Performance tab in the right pane.

• Client interface by right-clicking a shorthaul or backhaul interface in the navigation tree and 
clicking Performance History. The MWTM client interface provides access to RAN-O real-time 
performance statistics that you can use to troubleshoot problems that occur in real time. The zoom 
and navigation features quickly enable isolating and focusing on a problem area. 

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports
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Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > Web > Administrative; then click IPRAN OS README.

The Performance tab shows one or more graphs depending on the type of report chosen. These graphs 
depict send and receive rates of optimized IP traffic over a specified time range. The graphs display the 
traffic in bits per second. Each data series shows maximum, minimum, and average rates of optimized 
traffic.

The Performance tab for a backhaul interface shows total rates for GSM and UMTS traffic, including 
total error rates.

This section provides information about:

• Displaying Shorthaul Performance Statistics, page 11-22

• Displaying Backhaul Performance Statistics, page 11-23

Displaying Shorthaul Performance Statistics
The Shorthaul Performance tab for a shorthaul interface shows the maximum, minimum, and average 
rates for send and receive traffic. 

The Shorthaul Performance tab for a shorthaul interface contains: 

GUI Element Description

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-5.

Type A comprehensive summary of minimum, average, and maximum capacity statistics for send and receive 
traffic on a RAN shorthaul. You can choose from 15-minute, hourly, or daily capacity summary reports, 
or choose a custom range.

Table If you select the Output Type Table, the table contains:

• Data Type—Type of data, send or receive

• Average—Average of the data across the chosen time range

• Minimum—Minimum value across the chosen time range 

• Minimum Timestamp EDT—Time the minimum value occurred 

• Maximum—Maximum value across the chosen time range 

• Maximum Timestamp EDT—Time the maximum value occurred

Note If the Output Type is Table or CSV, the same data is presented but the column headings are labeled 
by data type (for example, Send Average and Receive Average).

Expand to Full 
Screen

If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier viewing.

Bits/Sec or 
Bytes/Sec

If Output Type is Graph, Y-axis label that shows traffic rate in bits per second. The Y axis automatically 
scales to the interface speed. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar to show 
the period for which no data is available.
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Displaying Backhaul Performance Statistics
The Performance tab for a backhaul interface shows minimum, average, and maximum traffic rates for 
send and receive traffic. You can also determine the percentage of backhaul utilization that various traffic 
types occupy. Error rates appear, too. 

The Performance tab for a backhaul interface contains: 

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic rates.

GUI Element Description

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph Series Editor. See the 
“Using the Toolbar” section on page 11-5.

Type Report Type. If you choose a Capacity Summary report, the report shows a comprehensive summary of 
minimum, average, and maximum capacity statistics for total traffic (GSM-Abis and UMTS-Iub), total 
GSM-Abis traffic, and total UMTS-Iub traffic. You can choose from 15-minute, hourly, or daily capacity 
summary reports. Error rates appear, too.

If Output Type is Graph, statistics appear in these graphs:

• Top—Capacity statistics for send traffic rates, including percentage of backhaul utilization (right side 
of graph).

• Middle—Capacity statistics for receive traffic rates, including percentage of backhaul utilization 
(right side of graph).

• Bottom—Error counts for send and receive traffic.

Type (continued) If you choose a Minimum, Average, or Maximum Capacity report, the tables and graphs show capacity 
statistics for the backhaul interface. You can choose from 15-minute, hourly, or daily capacity reports.

If Output Type is Graph, send and receive rate statistics appear in separate panes. Each pane shows two 
fully expandable graphs:

• Top—Shows total (GSM-Abis and UMTS-Iub), total GSM-Abis, and total UMTS-Iub traffic rates, 
including percentage of backhaul utilization (right side of graph).

• Bottom—Shows traffic rates for each shorthaul interface that belongs to the backhaul.
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Table Note Different tables appear depending on the report Type and Output Type selections.

If the Output Type is Graph, a table appears with these columns:

• Data Type—Type of data, send or received

• Average—Average of the data across the chosen time range

• Minimum—Minimum value across the chosen time range 

• Minimum Timestamp EDT—Time the minimum value occurred 

• Maximum—Maximum value across the chosen time range 

• Maximum Timestamp EDT—Time the maximum value occurred

Note If the Output Type is Table or CSV, similar data is presented but the column headings may vary. 
Also, if the value is N/A, that means no data is available.

Another table has these columns:

• Data Type—Category of error for which statistics are gathered. Types include optimization, missed 
packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over the 
duration of the data range that you chose.

Note You can sort the contents of the columns in ascending or descending order by clicking the column 
heading.

Expand to Full 
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window for easier viewing.

Bits/Sec or 
Bytes/Sec

If Output Type is Graph, primary Y-axis label (left side of graph) that shows traffic rate in bits per second. 
The Y axis automatically scales to the User Bandwidth. See the“Editing Properties for a RAN-O 
Backhaul” section on page 6-36. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar to show 
the period for which no data is available.

% Utilization If Output Type is Graph, secondary Y-axis label (right side of graph) that shows the backhaul utilization 
as a percentage of the User Bandwidth. The graph background has horizontal bars that are color-coded to 
indicate these thresholds:

• Overloaded—Top portion of graph.

• Warning—Middle portion of graph.

• Acceptable—Bottom portion of graph.

For definitions of these thresholds, see the “Threshold Information (RAN-O Only)” section on page 8-43.

To change the threshold settings, see the “Editing Properties for a RAN-O Backhaul” section on 
page 6-36.

Note If the % Utilization exceeds 100%, see Why does my backhaul utilization graph show greater than 
100% for transmit traffic?, page C-22.

Time X-axis label that shows a user-specified, historical time scale and the server time zone.

Legend Color-coded legend that shows labels for traffic and error rates.

GUI Elements Description
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Displaying Error Statistics
You can view error data for a shorthaul or backhaul interface in the MWTM: 

• Web interface by selecting an interface in the navigation tree and clicking the Shorthaul Errors or 
Errors tab in the content area.

• Client by right-clicking an interface in the navigation tree and clicking Error History.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > Web > Administrative; then click IPRAN OS README.

You view error data for a shorthaul or backhaul interface by selecting the interface in the navigation tree 
and clicking the Errors tab in the content area. The Errors tab shows total error counts and average error 
rates in table and graph format. 

This section provides information about:

• Displaying Shorthaul Error Statistics, page 11-26

• Displaying Backhaul Error Statistics, page 11-27
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Displaying Shorthaul Error Statistics

The Shorthaul Errors tab for a shorthaul interface shows a single table and a graph that shows the error 
rates and counts for different types of GSM-Abis and UMTS-Iub errors. 

The Shorthaul Errors tab for a shorthaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select report type, duration, and output type. See the “Using the Toolbar” section 
on page 11-5.

Type Report Type. If you choose an Error Summary report, the table and graph display a comprehensive 
summary of total error counts and average error rates for protocol, missed-packet, and miscellaneous 
errors for the chosen shorthaul. You can choose from 15-minute, hourly, or daily error summary reports. 
Statistics appear in table and graph format. 

If you choose an error report that is not a summary report, the table and graph displays protocol, missed 
packet, or miscellaneous errors for the shorthaul interface. You can choose from 15-minute, hourly, or 
daily error reports. Statistics appear in table and graph format.

For definitions of these error types, see:

• Protocol Failures, page 8-117

• Miscellaneous, page 8-118

• Missed Packets, page 8-119

Table Note Different tables and column headings appear depending on the report Type and Output Type 
selections.

If Output Type is Graph, a table appears with these columns:

• Data Type—Category of error for which statistics are gathered. Types include protocol, missed 
packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over 
the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.

Depending on the report Type selection, if the Output Type is Table or CSV, a table appears with 
multiple columns showing various error types and their counts. For definitions of these error types, see 
the:

• Protocol Failures, page 8-117

• Miscellaneous, page 8-118

• Missed Packets, page 8-119

Note You can sort the contents of the columns in ascending or descending order by clicking the 
column heading.

Expand to Full 
Screen

If Output Type is Graph, this text link displays a graph in a new, full-screen window for easier viewing.

Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate in bits per second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar to 
show the period for which no data is available.
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Displaying Backhaul Error Statistics

The Errors tab for a RAN backhaul interface shows a single table and a graph that shows the error rates 
and counts for different interfaces belonging to the backhaul. 

The Errors tab for a backhaul interface contains: 

Generating RAN Data Export Files
You can easily generate historical reports for RAN backhauls and shorthauls in the web interface. You 
can then export this data to a report with comma-separated values (CSV file). You can save this file to 
disk or open it with an application that you choose (for example, Microsoft Excel). 

To export RAN data:

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time scale and the server 
time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic and error rates.

GUI Elements Description

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph Series Editor. See the 
“Using the Toolbar” section on page 11-5.

Table Note Different tables and column headings appear depending on the report Type and Output Type 
selections.

If Output Type is Graph, a table appears with these columns:

• Data Type—Category of error for which statistics are gathered. Types include optimization, missed 
packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over 
the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.

If Output Type is Table, a table appears with columns for total error counts for various error types (for 
example, total GSM-Abis errors).

Note You can sort the contents of the columns in ascending or descending order by clicking the 
column heading.

Expand to Full 
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window for easier viewing.

Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate in bits per second. 

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time scale and the server 
time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic and error rates (for example, 
Total Errors UMTS-Iub).
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Step 1 Select a RAN backhaul or shorthaul in the navigation tree of the web interface.

Step 2 Click the Performance or Errors tab in the right pane.

Step 3 Generate a report.

Step 4 Click the Export the report as a CSV file icon . 

Displaying CSG2 Real-Time Statistics
The MWTM enables you to display real-time statistics for CSG2 nodes in the MWTM web interface. To 
display real-time statistics, select the node in the navigation tree and click the Statistics tab. The 
following categories of statistics appear:

• Global Statistics, page 11-28

• Load Statistics, page 11-29

• BMA Statistics, page 11-30

• Quota Server Statistics, page 11-31

• User Database Statistics, page 11-32

Note For toolbar details, see Using the Toolbar, page 11-5.

Global Statistics
The Global Statistics pane contains: 

Field Description

User Current The total number of users with one or more active sessions on the system.

Session Current The total number of sessions on the system. A session corresponds to a transmission control 
protocol (TCP) or user datagram protocol (UDP) flow.

User High Water The highest number of active users reported by the User Current field since its last reset.

Session High Water The highest number of active sessions reported by the Session Current field since its last reset.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 

GTP BMA Rejected Number of messages received from all the BMAs with reject cause code.

GTP BMA Dropped Total Number of messages dropped destined for any of the BMAs

GTP BMA Retransmit Number of messages retransmitted to all BMAs.

GTP QuotaMgr Dropped Number of messages received from all the Quota Managers with reject cause code. 

GTP QuotaMgr Dropped Total Number of messages dropped destined for any of the Quota Managers.

GTP QuotaMgr 
Retransmit

 Number of messages retransmitted to all the Quota Managers.
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Load Statistics
Load statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later.

The Load Statistics pane contains: 

Description

Statistics Type Column Defines the type of statistics for each row: 

• Radius Start Requests

• Session Create Requests

• BMA Messages

• Messages to Quota Server

• User Database Requests

Radius Start 
Requests

Allowed Number of outgoing Radius Start requests allowed. 

Allowed Rate Number of outgoing Radius Start requests allowed per second.

Allowed Rate 
High Water

The highest number of outgoing Radius Start requests allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for Radius Start requests in the IPC queue. 

Denied Number of outgoing Radius Start requests denied.

Denial Rate Number of outgoing Radius Start requests denied per second.

Denial Rate
High Water

The highest number of outgoing Radius Start requests denied per second. 

Session Create 
Requests

Allowed Number of outgoing Session Create Requests allowed. 

Allowed Rate Number of outgoing Session Create Requests allowed per second.

Allowed Rate 
High Water

The highest number of outgoing Session Create Requests allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for Session Create Requests in the IPC queue. 

Denied Number of outgoing Session Create Requests denied.

Denial Rate Number of outgoing Session Create Requests denied per second.

Denial Rate
High Water

The highest number of outgoing Session Create Requests denied per second. 
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BMA Statistics
The Billing Mediation Agent (BMA) Statistics pane contains: 

BMA Messages Allowed Number of outgoing BMA messages allowed. 

Allowed Rate Number of outgoing BMA messages allowed per second.

Allowed Rate 
High Water

The highest number of outgoing BMA messages allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for BMA messages in the IPC queue. 

Denied Number of outgoing BMA messages denied.

Denial Rate Number of outgoing BMA messages denied per second.

Denial Rate
High Water

The highest number of outgoing BMA messages denied per second. 

Messages to Quota 
Server

Allowed Number of outgoing messages to Quota Manager allowed. 

Allowed Rate Number of outgoing messages to Quota Manager allowed per second.

Allowed Rate 
High Water

The highest number of outgoing messages to Quota Manager allowed per second. 

IPC Queue Depth 
Tolerance

Maximum queue depth for messages to Quota Manager in the IPC queue. 

Denied Number of outgoing messages to Quota Manager denied.

Denial Rate Number of outgoing messages to Quota Manager denied per second.

Denial Rate
High Water

The highest number of outgoing messages to Quota Manager denied per second. 

User Database 
Requests

Allowed Number of outgoing User Database requests allowed. 

Allowed Rate Number of outgoing User Database requests allowed per second.

Allowed Rate 
High Water

The highest number of outgoing User Database requests allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for User Database requests in the IPC queue. 

Denied Number of outgoing User Database requests denied.

Denial Rate Number of outgoing User Database requests denied per second.

Denial Rate
High Water

The highest number of outgoing User Database requests denied per second. 

Description

Column Description

Server Name of the BMA server.

Port The UDP port of the BMA.

VRF Name Name of the virtual routing and forwarding (VRF) over which communication with BMA occurs. If no 
VRF is specified, the global routing table is used.
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Quota Server Statistics
The Quota Server Statistics pane contains: 

State The state of the BMA. Possible states include:

• Standby—The server is prepared to become active.

• Failed—The server has failed to respond to requests.

• Active—The server has been activated to receive requests.

• Echowait—An echo request to this billing mediation agent is waiting for a response.

• Nawait—A node-alive request to this billing mediation agent is waiting for a response.

• Suspended—The server has received a stop request from the operator.

Lost Records Total number of lost records since system initialization or the last time the counter wrapped.

Total Sent Total number of records sent to the billing mediation agent.

Failed Acks Number of acknowledgments received from the billing mediation agent for which there are no 
outstanding requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon indicates the trend (up or 
down) since the last poll.

Outstanding High 
Water

The highest number of messages waiting for acknowledgements as reported by the Outstanding field 
since its last reset. 

Bad Records Number of bad records received. These are records in which an error was detected while attempting to 
decode the contents.

Retransmits Number of messages retransmitted to the billing mediation agent.

Sent Rate Rate at which records are sent to the billing mediation agent.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 

Rate Interval The duration of time interval in Packet Rate and Ack Rate.

Packet Rate Number of packets sent to the BMA per second calculated over the interval indicated by Rate Interval.

Ack Rate Number of acknowledgments received from the BMA per second calculated over the interval indicated 
by Rate Interval.

Column Description

Column Description

Server Name of the quota server.

Port The UDP port of the quota server.

VRF Name Name of the VRF over which communication with the quota server occurs. If no VRF is specified, the 
global routing table is used.
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User Database Statistics
The user database is a service that translates a client IP address into a user identifier. The User Database 
Statistics pane contains: 

State The state of the quota manager. Possible states include:

• Standby—The quota manager is prepared to become active.

• Failed—The quota manager has failed to respond to requests.

• Active—The quota manager has been activated to receive requests.

• Echowait—An echo request to this quota manager is waiting for a response.

• Nawait—A node-alive request to this quota manager is waiting for a response.

• Suspended—The quota manager has received a stop request from the operator.

Lost Records Total number of lost records since system initialization or the last time the counter wrapped.

Total Sent Total number of records sent to the quota server.

Failed Acks Number of acknowledgments received from the quota server for which there are no outstanding 
requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon indicates the trend (up or 
down) since the last poll.

Outstanding High 
Water

The highest number of messages waiting for acknowledgements as reported by the Outstanding field 
since its last reset. 

Bad Records Number of bad records received. These are records in which an error was detected while attempting to 
decode the contents.

Retransmits Number of messages retransmitted to the quota manager.

Sent Rate Rate at which records are sent to the quota server.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 

Rate Interval The duration of time interval in Packet Rate and Ack Rate. 

Packet Rate Number of packets sent to the Quota Manager per second calculated over the interval indicated by Rate 
Interval.

Ack Rate Number of acknowledgments received from the Quota Manager per second calculated over the interval 
indicated by Rate Interval. 

Column Description

Column Description

Server Name of the user database server.

Port The listening UDP port of the server.

VRF Name Name of the VRF over which communication with user data server occurs. If no VRF is specified, the 
global routing table is used.
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Displaying BWG Real-Time Statistics
The MWTM enables you to display real-time statistics for Broadband Wireless Gateway (BWG) nodes 
in the MWTM web interface. To display BWG real-time statistics, select a BWG node in the navigation 
tree and click the Statistics tab. The following subtabs appear:

• Global Statistics, page 11-33

• Paths Statistics, page 11-41

• User Groups Statistics, page 11-42

Global Statistics
The Global statistics subtab shows global statistics for BWG nodes and contains:

• Status, page 11-34

• Creation and Deletion Statistics, page 11-34

• Miscellaneous Statistics, page 11-35

• Signaling Packet Statistics, page 11-36

• DHCP Packet Statistics, page 11-36

• Handoff Statistics, page 11-37

• Data Packet Statistics, page 11-38

• Dropped Packet Statistics, page 11-39

• Profile Statistics, page 11-40

• Rejected Statistics, page 11-41

Note For toolbar details, see Using the Toolbar, page 11-5.

State State of the user database. Possible values include:

Reset—State before the database is determined to be active.

Active—The database is available and processing requests.

Failed—The database has failed and is not processing requests.

Requests Number of user database requests.

User Identifiers 
Returned

Number of user identifiers returned.

Requests Resent Number of user database requests resent.

Request Timeouts Number of user database requests that have timed out.

Request Errors Number of errors returned on user database requests.

Requests Rate Rate of user database requests.

User Identifiers 
Returned Rate

Rate at which user identifiers are returned.

Column Description
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Status

The Status pane shows:

Creation and Deletion Statistics

The Creation and Deletion Statistics pane shows:

Field Description

Version Software version of the BWG.

Description Description of the physical instance of the BWG.

Operational State Current operational state of the BWG.

Session 
Redundancy Status

Indicates whether session redundancy is enabled or disabled.

Field Description

Base Stations • Maximum—Maximum number of base stations that can be concurrently 
supported by this BWG.

• Current—Current number of signaling paths to all base stations. One 
signaling path is created between the BWG and each base station, so the 
current number of signaling paths is equal to the number of base stations 
currently connected to the BWG. 

• Created Count—Total number of signaling paths created on this BWG which 
include active and past signaling paths.

• Created Rate—Rate at which signaling paths are created.

• Deleted Count—Total number of signaling paths deleted on this BWG.

• Deleted Rate—Rate at which signaling paths are deleted.

Data Paths • Maximum—N/A

• Current—Current number of data paths to all base stations.

• Created Count—Total number of data paths created on this BWG which 
include active and past data paths.

• Created Rate—Rate at which data paths are created.

• Deleted Count—Total number of data paths deleted on this BWG.

• Deleted Rate—Rate at which data paths are deleted.

Subscribers • Maximum—Maximum number of subscribers that can be concurrently 
supported by this BWG.

• Current—Number of subscribers currently connected to this BWG.

• Created Count—Total number of subscribers created on this BWG which 
includes active and past subscribers

• Created Rate—Rate at which subscribers are created.

• Deleted Count—Total number of subscribers deleted on this BWG.

• Deleted Rate—Rate at which subscribers are deleted.
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Miscellaneous Statistics

The Miscellaneous Statistics pane shows:

Sessions • Maximum—N/A

• Current—Number of sessions currently active on this BWG.

• Created Count—Total number of sessions created on this BWG which 
include active and past sessions.

• Created Rate—Rate at which sessions are created.

• Deleted Count—Total number of sessions deleted on this BWG.

• Deleted Rate—Rate at which sessions are deleted.

Flows • Maximum—N/A

• Current—Current number of flows for all sessions active on this BWG.

• Created Count—Total number of flows created on this BWG which include 
active and past flows.

• Created Rate—Rate at which flows are created.

• Deleted Count—Total number of flows deleted on this BWG.

• Deleted Rate—Rate at which flows are deleted.

Hosts • Maximum—N/A

• Current—Current number of hosts connected to this BWG.

• Created Count—Total number of hosts created on this BWG which include 
active and past hosts.

• Created Rate—Rate at which hosts are created.

• Deleted Count—Total number of hosts deleted on this BWG.

• Deleted Rate—Rate at which hosts are deleted.

Field Description

Field Description

Framed Routes Indicates the current number of unique framed routes downloaded from AAA and 
inserted into the IP routing table on a gateway.

Framed Router 
Subscribers

Indicates the number of subscribers using framed routes.

Auto-Provisioned 
Sessions

Indicates the number of auto-provisioned sessions on gateway.

Redirected 
Sessions

Indicates the number of sessions with all uplink IP packets redirected by the 
gateway.

Networks behind 
Mobile Stations

Indicates the number of networks behind mobile stations. 

Aged Out Hosts Count—Indicates the number of idle static hosts aged out.

Rate—Rate at which idle static hosts are aged out.
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Signaling Packet Statistics

The Signaling Packet Statistics pane shows:

DHCP Packet Statistics

The DHCP Packet Statistics pane shows:

Field Description

Pending • Count—Total number of signaling packets currently pending on this BWG

Processed • Count—Total number of signaling packets processed by this BWG.

• Rate—Rate at which signaling packets are processed.

Requeued • Count—Total number of signaling packets that were requeued on this BWG.

• Rate—Rate at which signaling packets are requeued.

Congestion Drops • Count—Number of signaling packets dropped when too many signaling 
packets are queued. The current queue limit is 1000 packets.

• Rate—Rate at which signaling packets are dropped.

Service Disabled 
Drops

• Count—Number of signaling packets dropped due to disabled service.

• Rate—Rate at which signaling packets are dropped.

Service Not Ready 
Drops

• Count—Number of signaling packets dropped while in non-active state for 
redundant configuration.

• Rate—Rate at which signaling packets are dropped.

Encapsulation 
Errors Drops

• Count—Number of signaling packets dropped due to encapsulation errors.

• Rate—Rate at which signaling packets are dropped.

Disposed Drops • Count—Number of signaling packets disposed by the BWG.

• Rate—Rate at which signaling packets are disposed.

Field Description

Discover • Count—Number of DHCP discover packets.

• Rate—Rate at which DHCP packets are discovered.

Offer • Count—Number of DHCP offer packets.

• Rate—Rate at which DHCP packets are offered.

Request • Count—Number of DHCP request packets.

• Rate—Rate at which DHCP packets are requested.

Decline • Count—Number of DHCP decline packets.

• Rate—Rate at which DHCP packets are declined.

Ack • Count—Number of DHCP acknowledged packets.

• Rate—Rate at which DHCP packets are acknowledged.

Nak • Count—Number of DHCP negatively acknowledged packets.

• Rate—Rate at which DHCP packets are negatively acknowledged.
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Handoff Statistics

The Handoff Statistics pane shows:

Release • Count—Number of DHCP release packets.

• Rate—Rate at which DHCP packets are released.

Inform • Count—Number of DHCP inform packets.

• Rate—Rate at which DHCP packets are informed.

Lease Query • Count—Number of DHCP lease query packets.

• Rate—Rate at which DHCP packets are lease queried.

Unknown • Count—Number of DHCP unknown packets.

• Rate—Rate at which DHCP packets are unknown.

Field Description

Field Description

Successful 
Handoffs

• Count—Number of successful session handoffs between Base Stations.

• Rate—Rate at which successful session handoffs occur.

Failed Handoffs • Count—Number of failed session handoffs between Base Stations.

• Rate—Rate at which failed session handoffs occur.

Successful CMAC 
Key Updates

• Count—Number of successful CMAC Key count updates related to handoff 
between base stations.

• Rate—Rate at which successful CMAC Key count updates are received.

Failed CMAC Key 
Updates

• Count—Number of failed CMAC Key count updates related to handoff 
between base stations.

• Rate—Rate at which failed CMAC Key count updates are received.

Successful Security 
Key Exchanges

• Count—Number of successful security key exchanges during handoff 
between base stations.

• Rate—Rate at which successful security key exchanges occur.

Failed Security Key 
Exchanges

• Count—Number of failed security key exchanges during handoff between 
base stations.

• Rate—Rate at which failed security key exchanges occur.
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Data Packet Statistics

The Data Packet Statistics pane shows:

Field Description

Received IP 
Packets

• Count—Number of data packets received by the BWG.

• Rate—Rate at which data packets are received by the BWG.

Received IP Bytes • Count—Number of data bytes received by the BWG.

• Rate—Rate at which data bytes are received by the BWG.

Sent IP Packets • Count—Number of data packets sent by the BWG.

• Rate—Rate at which data packets are sent by the BWG.

Sent IP Bytes • Count—Number of data bytes sent by the BWG.

• Rate—Rate at which data bytes are sent by the BWG.

Redirected IP 
Packets

• Count—Number of IP packets redirected by the BWG. 

• Rate—Rate at which IP packets are redirected by the BWG. 

Redirected IP Bytes • Count—Number of IP bytes redirected by the BWG. 

• Rate—Rate at which IP bytes are redirected by the BWG. 

Received Ethernet 
Packets

• Count—Number of ethernet packets received by the BWG. 

• Rate—Rate at which IP packets are redirected by the BWG.

Received Ethernet 
Bytes

• Count—Number of ethernet packets received by the BWG. 

• Rate—Rate at which ethernet packets are received by the BWG.

Sent Ethernet 
Packets

• Count—Number of ethernet packets sent by the BWG. 

• Rate—Rate at which ethernet packets are sent by the BWG. 

Sent Ethernet Byes • Count—Number of ethernet bytes sent by the BWG. 

• Rate—Rate at which ethernet bytes are sent by the BWG. 

Redirected Ethernet 
Packets

• Count—Number of ethernet packets redirected by the BWG. 

• Rate—Rate at which ethernet packets are redirected by the BWG.

Redirected Ethernet 
Bytes 

• Count—Number of ethernet bytes redirected by the BWG.

• Rate—Rate at which ethernet bytes are redirected by the BWG.

Punted Data 
Packets

• Count—Number data packets punted from the cef path to the process path. 

• Rate—Rate at which packets are punted from the cef path to the process 
path. 
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Dropped Packet Statistics

The Dropped Packet Statistics pane shows:

Field Description

Encapsulation 
Errors Drops

• Count—Number of data packets dropped due to encapsulation errors.

• Rate—Rate at which data packets are dropped.

Invalid Address 
Drops

• Count—Number of data packets dropped due to invalid IP address.

• Rate—Rate at which data packets are dropped.

Service Disabled 
Drops

• Count—Number of data packets dropped due to disabled service. 

• Rate—Rate at which data packets are dropped.

Invalid Protocol 
Type Drops

• Count—Number of data packets dropped due to invalid protocol types.

• Rate—Rate at which data packets are dropped.

Length Error Drops • Count—Number of data packets dropped due to IP packet length errors.

• Rate—Rate at which data packets are dropped.

Absent Key Drops • Count—Number of data packets dropped due to GRE key errors.

• Rate—Rate at which data packets are dropped.

Flow Not Found 
Drops

• Count—Number of data packets dropped due to flow not found errors.

• Rate—Rate at which data packets are dropped.

Flow Path Not 
Found Drops

• Count—Number of data packets dropped due to flow path not found errors.

• Rate—Rate at which data packets are dropped due to flow path not found 
errors. 

Flow Path Invalid 
Source Drops

• Count—Number of data packets dropped due to invalid source path address 
errors in the GRE header.

• Rate—Rate at which data packets are dropped due to invalid source path 
address errors in the GRE header.

Session Not Found 
Drops

• Count—Number of data packets dropped due to session not found errors for 
the GRE key.

• Rate—Rate at which data packets are dropped due to session not found 
errors. 

Subscriber Not 
Found Drops

• Count—Number of data packets dropped due to subscriber not found errors 
for the GRE key.

• Rate—Rate at which data packets are dropped due to subscriber not found 
errors.

Checksum Error 
Drops

• Count—Number of data packets dropped due to checksum errors.

• Rate—Rate at which data packets are dropped due to checksum errors.

Ingress Filtering 
Drops

• Count—Number of data packets dropped due to subscriber invalid source IP 
address errors.

• Rate—Rate at which data packets are dropped due to invalid source IP 
address errors. 
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Profile Statistics

The Profile Statistics pane shows:

Sequence Number 
Error Drops

• Count—Number of data packets dropped due to sequence number errors.

• Rate—Rate at which data packets are dropped due to sequence number 
errors.

Fragmented Drops • Count—Number of data packets dropped due to fragmented packet errors.

• Rate—Rate at which data packets dropped due to fragmented packet errors. 

Static IP Host 
Creation Failure 
Drops

• Count—Number of packets, such as upstream ARP and upstream data 
packets, dropped due to failure in creation of Static IP Host.

• Rate—Rate at which data packets are dropped due to failure in creation of 
Static IP Host. 

L2 Multicast and 
Broadcast Drops

• Number of L2 multicast and broadcast data packets other than ARP and 
DHCP dropped by BWG. 

• Rate—Rate at which L2 multicast and broadcast data packets are dropped. 

Throttled Path Punt 
Drops

• Count—Number of data packets dropped due to throttling of punts.

• Rate—Rate at which L2 multicast and broadcast data packets are dropped. 

Learned Static 
Hosts Drops

• Count—Number of data packets dropped due to BWG learning about static 
hosts from upstream data packets.

• Rate—Rate at which data packets are dropped due to BWG learning about 
static hosts from upstream data packets.

Field Description

Field Description

Service Flow 
Profile Not Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow profile. 

• Rate—Rate at which creation errors are received.

QoS Profile Not 
Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow QoS profile.

• Rate—Rate at which creation errors are received.

Classifier Profile 
Not Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow packet classifier profile.

• Rate—Rate at which service flow creation errors occur due to an 
unconfigured service flow packet classifier profile.

SLA Profile Not 
Found

• Count—Number number of session creation failures due to configuration 
error in Service Level Agreement (SLA) profile on BWG. 

• Rate—Rate at which session creation failures occur due to configuration 
error in Service Level Agreement (SLA) profile on BWG.
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Rejected Statistics

The Rejected Statistics pane shows:

Paths Statistics

Note For toolbar details, see Using the Toolbar, page 11-5.

The Paths statistics subtab shows information and statistics about each base station and contains:

Field Description

Rejected Base 
Station Paths 

• Count—Number of paths rejected because they exceeded the maximum 
number of base stations allowed to connect to this BWG.

• Rate—Rate at which paths are rejected because they exceeded the maximum 
number of base stations allowed to connect to this BWG.

Unapproved Base 
Station Sessions

• Count—Number of session creation and/or session handoffs rejected 
because the requesting base station is not approved for it.

• Rate—Rate at which created sessions and/or session handoffs are rejected 
because the base station is not approved for it. 

Rejected 
Subscriber Sessions

• Count—Number of sessions rejected due to exceeding the maximum number 
of allowed subscribers.

• Rate—Rate at which sessions that were rejected due to exceeding the 
maximum number of allowed subscribers. 

Rejected Session 
Flows

• Count—Number of flows that were rejected due to exceeding the        
maximum number of flows allowed per session.

• Rate—Rate at which flows were rejected due to exceeding the maximum 
number of flows allowed per session.

Session Deleted by 
the Gateway

• Count—Number of sessions deleted by the BWG.

• Rate—Rate at which sessions were deleted by the BWG. 

Rejected Hosts 
Open Requests

• Count—Number of hosts open requests rejected.

• Rate—Rate at which hosts open requests are rejected. 

Column Description

Remote IP Address Path IP address at the base station side.

Local IP Address Path IP address at the BWG side.

Type Path type, can be signaling or data.

Sessions Number of sessions over the path.

Flows Number of flows over the path.

Sent IP Packets 
Count

Total number of IP packets sent over the path.
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User Groups Statistics
The User Groups statistics subtab shows information and statistics for user groups and contains:

• Sessions and Flow Statistics, page 11-43

• Traffic Statistics, page 11-43

Note For toolbar details, see Using the Toolbar, page 11-5.

Sent IP Packets 
Rate

Rate at which IP packets are sent.

Sent IP Bits Count Total number of IP bits sent over the path.

Sent IP Bits Rate Rate at which IP bits are sent.

Received IP 
Packets Count

Total number of IP packets received over the path.

Received IP 
Packets Rate

Rate at which IP packets are received.

Received IP Bits 
Count

Total number of IP bits received over the path.

Received IP Bits 
Rate

Rate at which IP bits are received.

Sent Ethernet 
Packets Count

Total number of Ethernet packets sent over the path.

Sent Ethernet 
Packets Rate

Rate at which Ethernet packets are sent.

Sent Ethernet Bits 
Count

Total number of Ethernet bits sent over the path.

Sent Ethernet Bits 
Rate

Rate at which Ethernet bits are sent.

Received Ethernet 
Packets Count

Total number of Ethernet packets received over the path.

Received Ethernet 
Packets Rate

Rate at which Ethernet packets are received.

Received Ethernet 
Bits Count

Total number of Ethernet bits received over the path.

Received Ethernet 
Bits Rate

Rate at which Ethernet bits are received.

Column Description
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Sessions and Flow Statistics

The Sessions and Flow Statistics pane shows:

Traffic Statistics

The Traffic Statistics pane shows:

Column Description

Name Domain name identifying a user group.

Service Mode User group service mode.

Current Session: 
Count

Total number of active sessions per user group.

Sessions Created: 
Count

Total number of sessions created per user group.

Sessions Created: 
Rate

Rate at which sessions are created.

Sessions Deleted: 
Count

Total number of sessions deleted per user group.

Sessions Deleted: 
Rate

Rate at which sessions are deleted.

Flows Created: 
Count

Total number of active flows per user group.

Flows Created: 
Rate

Rate at which flows are created.

Flows Deleted: 
Count

Total number of flows created per user group.

Flows Deleted: 
Rate

Rate at which flows are deleted.

Group Overwrites: 
Count

Number of times this user group has been overwritten by the user group received 
from the AAA server. Users can belong to a particular user group at the time of 
initial entry and the AAA server can recategorize the user under a different user 
group after successful authentication.

Group Overwrites: 
Rate

Rate at which this user group has been overwritten by the user group received 
from the AAA server. 

Column Description

Name Domain name identifying a user group.

Service Mode User group service mode.

Sent IP Packets 
Count

Total number of IP packets sent over the path.

Sent IP Packets 
Rate

Rate at which IP packets are sent.

Sent IP Bits Count Total number of IP bits sent over the path.
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Sent IP Bits Rate Rate at which IP bits are sent.

Received IP 
Packets Count

Total number of IP packets received over the path.

Received IP 
Packets Rate

Rate at which IP packets are received.

Received IP Bits 
Count

Total number of IP bits received over the path.

Received IP Bits 
Rate

Rate at which IP bits are received.

Sent Ethernet 
Packets Count

Total number of Ethernet packets sent over the path.

Sent Ethernet 
Packets Rate

Rate at which Ethernet packets are sent.

Sent Ethernet Bits 
Count

Total number of Ethernet bits sent over the path.

Sent Ethernet Bits 
Rate

Rate at which Ethernet bits are sent.

Received Ethernet 
Packets Count

Total number of Ethernet packets received over the path.

Received Ethernet 
Packets Rate

Rate at which Ethernet packets are received.

Received Ethernet 
Bits Count

Total number of Ethernet bits received over the path.

Received Ethernet 
Bits Rate

Rate at which Ethernet bits are received.

Received: Packets 
Rate

Rate at which packets are received.

Received: Bits 
Count

Total number of bits received by this user group.

Received: Bits Rate Rate at which bits are received.

Invalid Source 
Packets: Count

Number of packets dropped due to invalid source address errors.

Invalid Source 
Packets: Rate

Rate at which packets are dropped.

Invalid Source Bits: 
Count

Number of bits dropped due to invalid source address errors.

Invalid Source Bits: 
Rate

Rate at which bits are dropped.

Column Description
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Displaying HA Real-Time Statistics
The MWTM enables you to display real-time statistics for Home Agent (HA) nodes in the MWTM web 
interface. To display HA real-time statistics, select a HA node in the navigation tree and click the 
Statistics tab. These subtabs appear:

• Global, page 11-45

• IP Local Pool Config, page 11-47

• IP Local Pool Stats, page 11-47

Global
The Global subtab shows global statistics for HA nodes and contains:

• Registrations Processed by AAA

• Registration Requests

• Standby Synchronization

Note For toolbar details, see Using the Toolbar, page 11-5.

Registrations Processed by AAA

The Registrations Processed by AAA pane shows:

Field Description

Maximum 
Processed in one 
minute

The maximum number of registration requests processed in a minute by the HA. 
It includes only those registration requests which were authenticated by the AAA 
server.

Average time to 
process (msecs)

The average time taken by the home agent to process a registration request. 
Calculations are based on only those registration requests that were authenticated 
by the AAA server.

Authenticated via 
AAA Server

• Count—The total number of registration requests processed by the home 
agent, including only those registration requests that were authenticated by 
the AAA server. 

• Rate—The total rate of registration requests processed by the home agent, 
including only those registration requests that were authenticated by the 
AAA server.
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Registration Requests

The Registration Requests pane shows:

Standby Synchronization

The Standby Synchronization pane shows:

Field Description

Current Bindings • Count—The current number of entries in the home agent’s mobility binding 
list. The home agent updates this number in response to registration events 
from mobile nodes.

• Rate—The count can increment or decrease, resulting in a positive or 
negative rate.

Initial Received • Count—Total number of initial registration requests received by the HA.

• Rate—Rate at which initial registration requests are received by the HA.

Initial Denied • Count—Total number of initial registration requests denied by the HA.

• Rate—Rate at which initial registration requests are denied by the HA.

All Received • Count—Total number of all registration requests received by the HA.

• Rate—Rate at which all registration requests are received by the HA.

All Denied • Count—Total number of all registration requests denied by the HA.

• Rate—Rate at which all registration requests are denied by the HA.

Field Description

Binding Updates 
Sent

• Count—Total number of binding updates sent by the home agent to a standby 
home agent.

• Rate—Total rate of binding updates sent by the home agent to a standby 
home agent.

Binding Updates 
Unacknowledged

• Count—Total number of binding updates sent by the home agent for which 
no acknowledgement is received from the standby home agent.

• Rate—Total rate of binding updates sent by the home agent for which no 
acknowledgement is received from the standby home agent.
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IP Local Pool Config

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Config subtab shows IP addresses for HA nodes and contains:

IP Local Pool Stats

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for HA nodes and contains:

Column Description

Name Name that uniquely identifies an IP local pool. This name must be unique among 
all the local IP pools even when they belong to different pool groups.

Low This object specifies the first IP address of the range of IP addresses contained 
by this pool entry. This address must be less than or equal to the High address.

High This object specifies the last IP address of the range of IP addresses mapped by 
this pool entry. If only a single address is being mapped, the value of this object 
is equal to the Low value.

Free Number of IP addresses available for use in the range of IP addresses.

In Use Number of IP addresses being used in the range of IP addresses.

Priority This object specifies the priority of the IP local pool. IP local pools will be used 
in assigning IP addresses in the order of priority.

Column Description

Name Name that uniquely identifies an IP local pool. This name must be unique among 
all the local IP pools even when they belong to different pool groups.

Free Number of IP addresses available for use in this IP local pool.

In Use Number of IP addresses being used in this IP local pool.

Maximum In Use Contains the high water mark of used addresses in an IP local pool since pool 
creation, since the system was restarted, or since this object was reset, whichever 
occurred last.

Low Threshold When the number of used addresses in an IP local pool falls below this threshold 
value, a notification is generated.

High Threshold When the number of used addresses in an IP local pool is equal or exceeds this 
threshold value, a notification is generated.

Low Threshold 
Percentage

When the percentage of used addresses in an IP local pool falls below this 
threshold value, a notification is generated. 

High Threshold 
Percentage

When the percentage of used addresses in an IP local pool is equal or exceeds 
this threshold value, a notification is generated. 
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Displaying GGSN Real-Time Statistics
The MWTM enables you to display real-time statistics only in the MWTM web interface for Gateway 
GPRS Support Nodes (GGSNs) that reside on the Service and Application Module for IP (SAMI). To 
display GGSN real-time statistics, select a SAMI-based GGSN node in the navigation tree and click the 
Statistics tab. These subtabs appear:

• Global, page 11-48

• SGSN Throughput, page 11-51

• APN General, page 11-52

• APN Throughput Statistics, page 11-53

• IP Local Pool Config, page 11-53

• IP Local Pool Stats, page 11-54

Global

Note For toolbar details, see Using the Toolbar, page 11-5.

The Global subtab shows global statistics for GGSN nodes and contains:

• GTP Statistics, page 11-48

• Charging Statistics, page 11-49

• GTP Throughput Statistics, page 11-49

• PDP Context Statistics, page 11-49

• AAA Statistics, page 11-50

• IP and UDP Statistics, page 11-50

GTP Statistics

The GTP Statistics pane displays statistics about the GPRS Tunneling Protocol (GTP) and contains:

Column Description

GTP Signaling 
Messages

GTP signaling messages sent between the Serving GPRS Support Node (SGSN) 
and GGSN.

G-PDU Messages GTP Packet Data Unit (G-PDU) messages received on an SGSN path.

G-PDU Octets Bytes sent and received in a GTP PDU message on an SGSN path.

Sent Count—Number of messages or bytes in the transmit direction.

Rate—The transmit rate of the messages or bytes.

Received Count—Number of messages or bytes in the receive direction.

Rate—The receive rate of the messages or bytes.
11-48
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 11      Accessing Data from the Web Interface
  Displaying GGSN Real-Time Statistics
Charging Statistics

The Charging Statistics pane displays count and rate statistics for GGSN charging messages and 
contains:

GTP Throughput Statistics

The GTP Throughput Statistics pane displays count and rate statistics about GTP throughput and 
contains:

PDP Context Statistics

The PDP Context Statistics pane shows count and rate values for these statistics:

Column Description

G-CDR Messages 
Pending

GGSN Call Detail Records (CDRs) that are pending.

G-CDR Messages 
Sent

G-CDRs that were sent.

Column Description

GTP Packets GTP packets between the GGSN and SGSN.

GTP Bytes GTP bytes between the GGSN and SGSN.

Sampling Interval 
in Minutes: 3

Global GTP throughput statistics on the GGSN for a duration of 3 minutes.

Sampling Interval 
in Minutes: 5

Global GTP throughput statistics on the GGSN for a duration of 5 minutes. 

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Upstream Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream Rate (per second) of downstream GTP traffic during the last sampling period.

Column Description

Active GTP v0 PDP Contexts PDP contexts (GTP version 0) that are active.

Active GTP v1 PDP Contexts PDP contexts (GTP version 1) that are active.

PDP Contexts Created PDP contexts that were created.

PDP Contexts Deleted PDP contexts that were deleted.

PDP Activations Rejected PDP contexts for which the activation request was rejected.

PDP Requests Dropped Create PDP context requests and delete PDP context requests that were dropped because the 
threshold limit was reached for the maximum number of Point-to-point (PPP) regeneration 
sessions allowed on the GGSN.
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AAA Statistics

The AAA Statistics pane shows:

IP and UDP Statistics

The IP and UDP Statistics pane shows:

PDP PPP-Regen Interfaces 
Created 

Device-specific interfaces created for association with PDP contexts regenerated to a PPP 
session.

Active PDP Contexts with 
Direct Tunnel 

Active PDP contexts with direct tunnel enabled.

PDP Contexts Deleted Without 
Waiting for the SGSN

PDPs deleted in the GGSN without waiting for a delete context response from the SGSN.

PDP Contexts Deleted Without 
Sending to the SGSN

PDPs deleted in the GGSN without sending a delete request to the SGSN.

Update PDP Context Requests 
Sent 

Update PDP context requests that the GGSN initiated and that were sent to the SGSN.

Update PDP Context 
Responses Received 

Update PDP context responses received from the SGSN for the GGSN-initiated update 
requests.

COA Messages Received Change of Authorization (COA) messages received at the GGSN.

COA Messages Dropped COA messages dropped at the GGSN.

COA QOS Updates Sent Update PDP requests for QOS changes that COA initiated and that are sent from the GGSN.

Error Indication Messages 
Received 

Error indication messages received on the GGSN.

Direct Tunnels Enabled Direct tunnels enabled for the PDP contexts in the GGSN.

Error Indications for DT PDP 
Contexts 

Error indications received for Direct Tunnel (DT) PDP contexts from the Radio Network 
Controller (RNC).

DT PDP Contexts Deleted Due 
to Update Response 

Direct tunnel PDP contexts deleted because of update response failure.

Column Description

Column Description

AAA Server Name Name of the Authentication, Authorization, and Accounting (AAA) server.

Server State Whether the server is up (operational) or down (not operational).

Authentication 
Requests

Count and rate values for requests to the AAA server for authentication.

Accounting 
Requests

Count and rate values for requests to the AAA server for accounting services.
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SGSN Throughput

Note For toolbar details, see Using the Toolbar, page 11-5.

The SGSN Throughput subtab shows:

Column Description

IP In Header Errors Input datagrams discarded because of errors in their IP headers, including bad 
checksums, version number mismatches, other format errors, time-to-live 
exceeded, and errors discovered in processing their IP options.

IP Out Discards Outbound packets that were discarded although no errors were detected. One 
reason for discarding a packet would be to free buffer space.

IP Out No Routes IP datagrams discarded because no route could be found to transmit them. This 
statistic includes any datagrams that a host cannot route because all its default 
gateways are down.

IP Reassembly 
Fails 

Failures detected by the IP reassembly algorithm.

IP Routing 
Discards 

Routing entries that were discarded even though they are valid. One reason for 
discarding a routing entry would be to free buffer space for other routing entries.

UDP In Datagrams UDP datagrams delivered to UDP users.

Column Description

SGSN Name Name of the SGSN.

Sampling Interval 
in Minutes: 3

Throughput statistics on the SGSN for a duration of 3 minutes. 

Sampling Interval 
in Minutes: 5

Throughput statistics on the SGSN for a duration of 5 minutes. 

Upstream Packets Rate (per second) of upstream packets sent on this SGSN during the last sampling 
period.

Upstream Bytes Rate (per second) of upstream bytes sent on this SGSN during the last sampling 
period.

Downstream 
Packets

Rate (per second) of downstream packets sent on this SGSN during the last 
sampling period.

Downstream Bytes Rate (per second) of downstream bytes sent on this SGSN during the last 
sampling period.

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.
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APN General

Note For toolbar details, see Using the Toolbar, page 11-5.

The APN General subtab contains:

• APN Miscellaneous Statistics, page 11-52

• APN PDP Context Statistics, page 11-52

• APN Throughput Statistics, page 11-53

APN Miscellaneous Statistics

To view the APN Miscellaneous Statistics table, choose this option from the Type drop-down menu. The 
GUI displays count and rate values for these statistics:

APN PDP Context Statistics

To view the APN PDP Context Statistics table, choose this option from the Type drop-down menu. The 
GUI displays the count and rate values for these statistics:

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Upstream Payload 
Volume

The total payload volume in upstream traffic.

Downstream 
Payload Volume

The total payload volume in downstream traffic.

Source Address 
Violations

Upstream Transport PDUs (T-PDUs) that have been dropped because of source 
address violations.

COA Messages 
Received

COA messages received on this APN. 

COA Messages 
Acknowledged

COA messages that were acknowledged by the GGSN with a COA ACK. 

Direct Tunnels 
Enabled

Direct tunnels enabled for the PDP contexts on this APN.

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

PDP Activations Initiated by MS PDP context activation procedures initiated by any mobile station (MS) on this 
APN.

PDP Activations Completed by MS Successfully completed PDP context activation procedures initiated by MS on this 
APN.
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APN Throughput Statistics

To view the APN Throughput Statistics table, choose this option from the Type drop-down menu. The 
GUI displays the count and rate values for these statistics:

IP Local Pool Config

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Config subtab shows IP addresses for GGSN nodes and contains:

PDP Deactivations Initiated by MS PDP context deactivation procedures initiated by the MS on this APN.

PDP Deactivations Completed by MS Successfully completed PDP context deactivation procedures initiated by the MS.

PDP Deactivations Initiated by GGSN PDP context deactivation procedures initiated by the GGSN.

PDP Deactivations Completed by GGSN Successfully completed PDP context deactivation procedures initiated by the 
GGSN.

Active PDP Contexts Active PDP contexts in the APN.

Update PDP Context Requests Sent GGSN-initiated update requests sent on this APN.

Update PDP Context Responses 
Received

Successful update responses received from the SGSN with a cause value of 
Request accepted for the GGSN-initiated update requests on this APN.

Column Description

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Sampling Interval in 
Minutes: 3

Throughput statistics on the APN for a duration of 3 minutes. 

Sampling Interval in 
Minutes: 5

Throughput statistics on the APN for a duration of 5 minutes. 

Upstream Packets Rate (per second) of upstream packets sent on this APN during the last sampling period.

Upstream Bytes Rate (per second) of upstream bytes sent on this APN during the last sampling period.

Downstream Packets Rate (per second) of downstream packets sent on this APN during the last sampling period.

Downstream Bytes Rate (per second) of downstream bytes sent on this APN during the last sampling period.

Data age (minutes) The difference in minutes between the time when the data was collected and retrieved. This is the 
time that has elapsed after the previous collection or update of the data.
11-53
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1

OL-13314-01



 

Chapter 11      Accessing Data from the Web Interface
  Displaying PWE3 Real-Time Statistics
IP Local Pool Stats

Note For toolbar details, see Using the Toolbar, page 11-5.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for GGSN nodes and contains:

Displaying PWE3 Real-Time Statistics
The MWTM enables you to display PWE3 real-time statistics in the MWTM web interface. Because the 
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar, 
the PWE3 real-time statistics are described in Viewing PWE3 Statistics, page 8-110.

Displaying TDM Real-Time Statistics
The MWTM enables you to display TDM real-time statistics in the MWTM web interface. Because the 
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar, 
the TDM real-time statistics are described in Viewing TDM Statistics, page 8-95. 

Column Description

Name Name of the IP local pool.

Addresses Low—The first IP address of the range of IP addresses contained by this pool 
entry.

High—The last IP address of the range of IP addresses mapped by this pool entry.

Free—Number of IP addresses available for use within the range of IP addresses.

In Use—Number of IP addresses being used within the range of IP addresses.

Column Description

Name Name of the IP local pool.

Addresses Free—Number of IP addresses available for use in this IP local pool.

In Use—Number of IP addresses being used in this IP local pool.

Maximum in Use—The maximum number of used addresses in an IP local pool 
since pool creation, since the system was restarted, or since this object was reset, 
whichever occurred last.
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